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 Actisense 
Important Notices 
 
The Actisense NMEA Data Combiner (NDC) is intended for use in a marine environment, 
primarily for below deck use.  If the unit is to be used in a more severe environment, such 
use may be considered misuse under the seller’s warranty. 
 
The Actisense NMEA Data Combiner (NDC) has been certified to comply with the 
European directive for Electro-Magnetic Compatibility (EN60945), and is appropriately CE 
marked.  Operation of the unit should be in conjunction with appropriate CE approved 
shielded connectors and cabling used in accordance with the CE directive EN60945.  Any 
EMC related issues should be reported to Active Research immediately to allow the 
company to rectify or resolve EMC related problems in accordance with its obligations under 
EN60945. 
 
If the unit is connected such that compliance failure occurs beyond the company’s control, 
the company shall not be held responsible for the compliance failure until suitable EMC 
guidelines for connection are seen to have been taken. 
 
 

Notices 
 
When using this document, keep the following in mind: 
 
The products described in this manual and the specifications thereof may be changed 
without prior notice.  To obtain up-to-date information and/or specifications, contact Active 
Research Limited or visit the Actisense website (www.actisense.com). 
 
Active Research Limited will not be liable for infringement of copyright, industrial property 
right, or other rights of a third party caused by the use of information or drawings described 
in this manual. 
 
All rights are reserved: The contents of this manual may not be transferred or copied without 
the express permission of Active Research Limited. 
 
Active Research Limited will not be held responsible for any damage to the user that may 
result from accidents or any other reasons during operation of the user’s unit according to 
this document. 
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 NMEA Data Combiner
Foreword 
 
Actisense recognises that instructions are often skipped, so we have aimed to write this 
document in an informative, yet direct manner that will aid the user. We have tried to cover 
all the points a typical user may need to know.  Please read all sections before installing and 
using the Actisense NMEA Data Combiner product and its related software programs. 
 
 

Introduction 
 
The Actisense NMEA Data Combiner (NDC) product developed out of the requirement to 
solve two fundamental problems with the existing marine industry NMEA 0183 
communications standard and the soon to be released NMEA 2000 standard.  
 
In theory, the NMEA 0183 standard allows any suitably designed marine electronic device to 
share its gathered information with any other device on a vessel. Unfortunately, there is one 
very large drawback with this standard - only one device on a connected network can 
actually send data (a single talker), with multiple devices (determined by the current limit of 
the sending unit) listening to that data (multiple listeners).  
 
If the vessel owner has an instrument that ideally requires the data output of two or more 
devices, for example a chart plotter, then the owner has no alternative but to settle on 
connecting only the most important device (that which supplies the most used information), 
usually the GPS unit. 
 
What happens if the owner prefers the vessels gyro compass output to that of the GPS, or 
requires that the current depth be displayed on the plotted chart to help avoid the possible 
case of running the vessel aground on a shifting sand bank? The NMEA 0183 standard 
cannot supply an answer to those questions as it can handle only one transmitting device. 
 
The second problem is that the soon to be released NMEA 2000 standard is not backward 
compatible with NMEA 0183 in any way whatsoever. It uses very different and incompatible 
information transfer ideas and cables. The NMEA 0183 standard is over 10 years old and no 
amount of compromise from the NMEA committee would have ever made NMEA 2000 
compatible with the existing standard and allowed it to meet the greatly increased industry 
requirements of today. 
 
These two elementary problems can be solved simply and easily with the Actisense NMEA 
Data Combiner’s very flexible design approach.  
 
By using the Actisense NMEA Data Combiner, all NMEA 0183 devices can share their 
information with each other (multiple talkers – multiple listeners) and any new NMEA 2000 
device can listen to the NMEA 0183 information as if it was coming from another NMEA 
2000 instrument (effectively making NMEA 0183 compatible with NMEA 2000). Refer to the 
Features section for details on NMEA 2000 functionality. 
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General features 
 
4 NMEA 0183 data input ports 

Each NMEA 0183 input port has an “Inclusion List” that details all the NMEA sentences that 
are allowed to pass thought the NMEA Data Combiner (NDC) and out on the combined 
NMEA 0183 output. This allows the NDC to filter out all unwanted NMEA data and so reduce 
the loading on the NMEA combined output. 
 
Each NMEA 0183 input port also has a priority level. This is set by default to the logical order 
that matches the port numbers, i.e. port 1 is the highest priority and port 4 the lowest. 
 
 
An NMEA 0183 data combined output port 

This output combines the input data into one standard NMEA output.  As the inputs and the 
output are of the same baud rate, the combined input rate may exceed the output rate.  The 
combiner contains special software to ensure that new data of the same type as older data, 
still in the buffer, will overwrite the older sentence.  This ensures that the combiner cannot 
build up excess old data in the case where the output stream is fully loaded.  Using a higher 
baud rate on this port will improve its’ throughput, but may not be compatible with following 
equipment, if the baud rate on that equipment is fixed to 4800 baud (the NMEA standard). 
 
 
A PC compatible RS-232 bi-directional port 

A PC can use the RS-232 port to read all the NMEA data traversing through the NDC. This 
allows for the possibility of a “virtual cockpit” of instruments displaying all available data in 
any manner the user requires (available from a number of manufacturers). 
 
All the above ports are re-configurable and offer various Baud rates to improve device 
connection compatibility with other NMEA 0183 instruments. 
 
The NDC will be able to act as an NMEA 0183 to NMEA 2000 upgrade bridge, converting all 
NMEA 0183 data into standard NMEA 2000 packets that can be read by any suitably 
equipped device on the vessels NMEA 2000 CAN bus network. This ability will require a 
flash upgrade, as the NMEA 2000 standard is not yet finalised; please contact Active 
Research Limited / monitor the Actisense website for further information. 
 
 

Software updates 
 
The NDC’s built-in software is held in “flash” memory, and so can be quickly and easily 
updated / “flashed” by using a simple Windows (95/98/ME and NT/2000) user interface 
program running on a connected PC. 
 
It is our policy to provide these updates free on our website, www.actisense.com, so that 
your combiner can become more sophisticated with time, and should there be any bugs 
reported in the software, they can be promptly fixed without the unit coming out of 
commission.  This upgrade can be performed with the unit completely in-situ, via a PC 
connected to the RS232 port.  
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 NMEA Data Combiner
Technical features 
 
Fujitsu 16-bit high-speed micro-controller capable of 8 million instructions per second. 
 
Flash ROM technology that supports automatic programming for quick and easy updates, 
10,000 erase cycles and a 10-year Data Retention provides carefree user configuration.  
 
Full-CAN interface that is compatible with the soon to be released NMEA 2000 marine 
communications standard. The NDC’s built-in software will require flash upgrading when the 
NMEA committee finalise the new marine industry standard protocol. 
 
On-board memory store allows buffering of short term NMEA data, allowing the unit to 
smooth short-term peaks in the NMEA data flow. 
 
NMEA 0183 inputs are opto-isolated differential inputs to fully comply with the NMEA 0183 
standard specification. This allows the inputs to work correctly with long cable runs and in a 
noisy environment.  Typical operating voltage is 2.0V to 15V.  The unit can withstand +/- 35V 
continuously, and can withstand +40V transients.  The opto-isolators can protect any 
upstream equipment (chart plotter / PC / radar etc.) from up to 2000V of common mode 
voltage difference. 
 
NMEA 0183 full-differential output driver.  This can drive up to 20 typical NMEA 0183 
device loads, with a 100mA (maximum) drive capability.  The full-differential output ensures 
better quality communications and lower noise emissions on unshielded twisted pair cabling. 
 
Full specification RS232 interface ensures that any marine electronic device that has an 
RS-232 port connected PC need miss no input NMEA data.  Enables connection to a 
standard PC, allowing data to be read, and the unit to be freely updated via the supplied 
flash upgrade software. 
 
Low Power Consumption that is typically 100-110mA at 12 volts and 50-60mA at 24 volts. 
 
A diagnostic LED indicates the operation mode of the NDC, if any faults have been 
detected, or the peak loading currently on any one of the NMEA inputs. 
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Connections 
 

1 2 3 4
Out RS-232 CAN Bus Bat.

+ + + + + +
Ch. Ch. Ch. Ch.

NMEA

Actisense NMEA Data Combiner

G

Female Male

 
 

Figure 1 – External connections 
 
 
The NMEA Data Combiner (NDC) has external connections for: - 
 

1. Four NMEA 0183 inputs via male ¼ inch (6.35 mm) crimps. 
All NMEA 0183 inputs are of the differential opto-isolated type and use Actisense 
low current drain circuitry (2mA @ 2.0V) to conform in full with the NMEA 0183 
marine electronic device network communication standard, and are flexible enough 
to interface to most fully and partially compliant devices. 
 

2. An NMEA (data combined) 0183 output via male ¼ inch (6.35 mm) crimps. 
The NMEA 0183 output comprises of three connections: ‘+’, ‘-‘ and ‘Ground’ and 
conforms in full to the NMEA 0183 standard. This allows the NDC to interface to 
various different devices that require any combination of these outputs.  
 

3. An RS-232 input/output via a female 9-pin D-type connector. 
The bi-directional RS-232 port is designed for direct connection to a Personal 
Computer (PC) or other marine device capable of interfacing to an RS-232 port. 
  

4. An NMEA 2000 CAN Bus input/output via a male 9-pin D-type connector. 
The NMEA 2000 port is designed to connect to the vessel’s CAN Bus network by use 
of a conversion cable (supplied directly from Actisense). 
 

5. Battery supply input via male ¼ inch (6.35 mm) crimps. 
 
 
Note: 

1. To complete the NMEA 0183 standard all device interconnection NMEA cables used 
should meet the two-conductor, shielded, twisted pair configuration specification. 

 
2. Refer to the Specifications section for the full details on input/output specifications.  
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Connecting to NMEA devices 
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Figure 2 – NMEA 0183 connections 
 
 
NMEA 0183 Inputs 
The NMEA 0183 differential opto-isolated inputs are designed to handle a variety of NMEA 
0183 device output specifications. Please determine (from device manufacturer’s 
information) if the device(s) required to be connected to the Actisense NDC conforms in full 
to the NMEA 0183 network communication standard. If it does not, the flexible Actisense 
NDC inputs should still be capable of interfacing with the device, though this is not 
guaranteed.  The diagram above shows a typical installation with both fully compliant NMEA 
devices with differential inputs/outputs, and non-differential output devices that output NMEA 
using the ground line as the “NMEA -” line. 
 
NMEA Device’s 1, 3 and 4: These devices conform in full to the NMEA 0183 standard. 
Devices 1 and 4 share the same connection ID’s as the Actisense NDC, so connection is a 
simple matter of matching the ID’s (refer to figure 2). Device 3 uses the RS485 convention 
connection ID’s. Simply connect ‘A‘ to ‘+‘ and ‘B’ to ‘ -’ (refer to figure 2). 
 
NMEA Device 2: This device does not conform completely to the NMEA 0183 standard. 
However, by connecting ‘+‘ to ‘+‘ and its ‘G/Ground’ to the NDC “NMEA-” the NDC should 
be able to receive the NMEA data correctly. 
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NMEA 0183 Output 
The NMEA 0183 buffered output is capable of driving up to 20 NMEA 0183 fully compliant 
listening devices, or a mixture of NMEA 0183 devices and a Personal Computer (PC) 
communication port. 
 

NMEA Device’s A and C: These devices conform in full to the NMEA 0183 standard 
and their connection ID’s match that of the NDC. 

 
Personal Computer: Whilst the RS-232 port is designed for connection to a PC, the 
NMEA 0183 output is also capable of being read by most PCs. Simply connect ‘+’ to 
‘Rx’ and ’G’ to ‘Gnd’ on a standard D-type (probably male) connector. 

 
NMEA Device B: This device does not conform in full to the NMEA 0183 standard. 
However, by connecting ‘-‘ to ‘-‘ and ‘G/Ground’ to ‘Gnd’ the device should be able to 
receive the NMEA data correctly, though this is not guaranteed. 
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Connecting to a Personal Computer 
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Figure 3 – RS-232, CAN Bus and Battery connections 
 
 
The RS-232 port can be connected to a PC communications port using an off-the-shelf 
computer one-to-one (not Null modem) extension cable (refer to figure 3). However, if the 
required cable length is not available or cost is a prohibitive factor, a cable conforming the 
following specification should be constructed instead: 
 

1. A D-type male (plug) connector for the Actisense NDC end of the cable 
 

2. A D-type female (socket) connector for the PC end of the cable 
 

3. Minimum of 3 cores are required in a shielded cable. Higher quality cable will 
naturally yield higher performance / higher noise-to-signal ratio (NSR). 

 
4. Cable shield should only be connected to the ground core (or D-type connector’s 

shell if it is metal) at the computer end of the cable. 
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Figure 4 – RS-232 cable connections 
 
Note:  

1. Wire colours are for guidance only.  
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Connecting to the CAN bus 

 
The user supported method of connecting the Actisense NDC to the vessel’s CAN bus 
network is with the directly supplied 9-pin D-type to NMEA 2000 converter cable. Please 
contact Active Research Limited (refer to Contact Information section) if you require such a 
converter cable. 
 
Alternatively, if the supplied cable length is not suitable or cost is a prohibitive factor, a cable 
of the required length conforming the NMEA 2000 CAN bus specification should be 
purchased and one end modified to connect to a standard 9-pin D-type female (socket) 
connector (refer to figure 5). 
 
The Actisense NDC connector end should be wired thus: 
 

 

 

 

 
Female Connector

 

Fe
m

al
e Pin 5 (CAN Ground) 

Pin 4 (CAN H) 

 
Pin 1 (CAN Power) 

Pin 7 (CAN L) 

NMEA 2000
CAN Bus cable

 
Figure 5 – CAN cable connections 

 
Note:  

1. Wire colours are an example only; actual colours vary between cable manufacturers. 
 
 
Connecting to the battery supply 

 
The Actisense NDC should be wired to the vessel’s battery supply in the most direct 
manner possible to minimize interference from other electronic devices. The cable used 
should be of sufficient gauge to handle the power requirements of the Actisense NDC (refer 
to the Specifications sections). 
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 NMEA Data Combiner
Using the Control Centre 
 
The Actisense NMEA Data Combiner hardware can be configured, monitored and tested by 
its own dedicated Control Centre program. This section provides a users guide to all the 
modes of operation possible with the Control Centre program. 
 
This program is currently only available for Windows 95/98/ME and NT/2000 platforms, 
however, it has been proven possible to use the Control Centre on a Mac running Windows 
emulation software. 
 
 
Main window 

 

 
 

Figure 6 – Control Centre main window 
 
 
The Control Centre main window allows the user access to all the NDC hardware 
configuration, monitor and test operations, and adjustment of the Control Centre programs 
actual appearance. 
 
 The Control Centre is capable of displaying a large array of data and information, and not all 
will be of interest to every user. Therefore, the user can select which information/status 
windows are shown and which are hidden. To meet user specific requirements, any shown 
windows can be repositioned on the screen by dragging them with the mouse. If when a 
window is dropped (the left mouse button is released after the drag operation) it is close 
enough to an adjacent windows edge it will snap that windows edge. This allows for easy 
and quick arrangement of the Control Centre’s windows, and any changes to the programs 
appearance will be remembered for subsequent sessions. 
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Pull-down menus 
 
The main window has five standard pull-down menus: - 
 

File → Load / Save Configuration File: The Control Centre will automatically save its 
appearance and other settings to file “ControlCentre.ini” so that the same settings 
can be used in subsequent sessions. If the user requires more than one configuration 
set up (for different vessel installations) with unique Inclusion Lists and port 
configurations for example, then each set up can be saved and loaded back from here. 

 
Note: Do not attempt to edit the “ControlCentre.ini” file by hand, as this will result in 
all configuration settings being lost. 

 
File → Exit: Closes the Control Centre program. If the Inclusion Lists and/or the Port 
Configurations have been altered, but not yet transferred to the NDC hardware, the 
user will be asked to confirm the exit command (as all alterations will otherwise be lost 
when the program closes). 

 
Options → Configure Inclusion Lists: Displays the Inclusion List configuration tab of 
the main window. Refer to the respective window sub-section below for details. 

 
Options → Configure Ports: Displays the Port configuration tab of the main window. 
Refer to the respective window sub-section below for details. 

 
Options → Test Hardware: Displays the Test hardware tab of the main window. Refer 
to the respective window sub-section below for details. 

 
Comms → Comm Port 1-5: Selects the PC communications port that the NDC 
hardware is attached to. The baud rate will default to 38400 (the NDC hardware 
default). If received data errors are detected the Control Centre will attempt to match 
the NDC hardware’s Baud rate. 

 
Window → Control Centre Port Status: Displays the Control Centre’s port status 
window. Refer to the respective window sub-section below for details. 

 
Window → NDC Hardware Port Status: Displays the NDC hardware’s port status 
window. Refer to the respective window sub-section below for details. 

 
Window → NDC Hardware Connect Status: Displays the NDC hardware’s 
connection status window. Refer to the respective window sub-section below for 
details. 

 
Window → NDC Hardware Information: Displays the NDC hardware’s information 
window. Refer to the respective window sub-section below for details. 

 
Help → Control Centre Help: Displays the quick reference Control Centre help 
information (a cut-down context sensitive version of this document). 

 
Help → About Control Centre: Displays the Control Centre’s software version 
number and the Actisense / Active Research Limited contact information. 
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 NMEA Data Combiner
Control Tabs/Buttons 
 
The main window has three control tabs (buttons) along its top: Inclusion List, Port 
Configure and Test Hardware. These tabs display all the associated information in the area 
below them (refer to figures 6 - 9) and act just like tabs in a filing cabinet (doing the same job 
as the items in the Options pull-down menu). Refer to the respective tab sub-sections below 
for more details. 
 
The main window also has an Exit control button that closes the Control Centre program. As 
with the menu exit control, if the Inclusion Lists and/or the Port Configurations have been 
altered, but not yet transferred to the NDC hardware, the user will be asked to confirm the 
exit command. 
 
 
Inclusion List configuration tab 

 

 
 

Figure 7 – Control Centre Inclusion List configuration tab 
 
 
The Inclusion List configuration tab of the main window allows the user to select which 
NMEA sentences are to be included in the onward data transmission from the NMEA Data 
Combiner. Each of the four NMEA input ports has its own Inclusion List, so that each can be 
tuned separately to match the NMEA device attached to that port. 
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Why is there a need for Inclusion Lists? 
 
Each of the four NMEA input ports can transfer anything up to 480 bytes of data per second, 
making a total of 1920 bytes/second. The data combined output of the NDC is also forced 
(by the NMEA 0183 standard) to send a maximum of 480 bytes/second. It can be seen, that 
with a maximum of 1920 bytes being received and maximum of 480 bytes sent in a second, 
there exists the distinct possibility that some data may require removal to balance this 
equation. The Actisense NDC achieves this reduction in an intelligent manner with Inclusion 
Lists and Port Priorities. 
 
 
Is some of the NMEA data really unnecessary? 
 
Some NMEA instruments output a large number of sentences every period (usually 1-3 
seconds), some of which are of absolutely no use to the average boat owner, and just clog 
up the NMEA network. Most GPS units are especially guilty of this and not all allow the user 
to reduce the number of unwanted sentences that are transmitted. Of those that do, the 
procedure can often be fiddly and time consuming. 
 
The Actisense NDC can filter the incoming NMEA data to remove any sentences that are 
deemed unnecessary by the user. 
 
For example, most GPS units automatically output the ‘GSV’ sentences (normally 2 but 
could be as many as 4), which give details of all the satellites that are currently in view. All of 
this information is of no use to 99% of users, but this alone can use up to 5% of the available 
NMEA bandwidth/capacity. 
 
The Actisense NDC 'Inclusion List' default is to allow all sentences through. The user can 
modify these lists using a simple ‘tick-the-box’ panel from within the Control Centre. 
 
 
How to change the Inclusion Lists 
 
The Inclusion List configuration tab consists of two groups of sentence tick boxes and a box 
showing the total number of selected sentences, an NMEA channel selection pull-down list, 
and Get from hardware, Reset and OK control buttons (refer to figure 7). 
 

Channel selection list: determines which channel (port) has its inclusion list displayed 
for editing with the tick-boxes. 

 
Left tick-box group: has a separate tick box for every possible NMEA 0183 sentence 
and is intended for the advanced user to fine tune the selection to exactly what is 
required. 

 
Right tick-box group: has a tick box for each NMEA sentence collection and is 
primarily intended for the novice user who does not know which sentences contain 
what information. The NMEA sentence collections are designed for quick list 
configuration; each collection influences all the NMEA sentence tick boxes in the left 
group that contain the respective information. 
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The tick-box operation is straightforward: if the box is ticked, the corresponding NMEA 
sentence/collection will be transferred from the NDC input to the NDC combined 
output.  Conversely, if the box is not ticked, any NMEA sentences of that type will be 
blocked from onward transmission. 
 
Sentence Total: a tally of the number of NMEA sentences currently selected/enabled 
for the current channel/port is displayed in the top right corner. 

 
Get from hardware: requests the current Inclusion List information (for all 
channels/ports) from the NDC hardware attached to the PC communications port. This 
will overwrite any current settings of the Control Centre Inclusion Lists; if the user 
requires that the current settings be remembered, the File → Save Configuration file 
main window menu option should be used before using this hardware read operation. 

 
Reset: returns all channel/port Inclusion Lists to the factory default – all sentences are 
enabled on all channels/ports. 
 
OK: finalises the Inclusion List editing operation. If any alterations to the list have 
occurred the Control Centre will now attempt to download the new settings to the 
attached Actisense NDC hardware. The Flash Hardware window will appear for the 
duration of the download and the details of the conversation can be viewed in the NDC 
Hardware Connection Status window. 
 
 

Procedure 
1. Remembering that the ports have a priority setting (that only has a effect during high 

loads), choose which device to connect to which channel/port. Place the most 
important device on channel 1 and so on. If the ‘Inclusion Lists’ are tuned to allow 
only the required data of each device through, then the port priorities will normally not 
come into operation (as the maximum output data rate will usually not be exceeded). 

 
2. Starting with channel/port 1, place a tick next to all required NMEA sentences (using 

the individual tick boxes, the group tick boxes or a combination of both), by left 
clicking on the text or box with the mouse pointer. 

 
3. Do the same for any other channel that you intend to use. Use the Channel selection 

list control to change the channel/port - left click on the controls down arrow to 
display the list and then select the required channel number. Any combination of 
channels can be used – for example, in a two-device set-up channel’s 1 and 3, or 2 
and 3 etc. could be used. 

 
4. Once you are happy with the setting of all used channels, press the OK control 

button. If for some reason the Control Centre has not been able to detect the NDC 
hardware, it cannot start the data transfer process. If this happens check all cable 
connections, Control Centre communication settings (port number and Baud rate) 
and battery power to the NDC hardware (the diagnostic LED should be lit and either 
‘Green’ or ‘Amber’). 

 
5. When the Control Centre has detected the NDC hardware (the hardware information 

will be displayed in the NDC Hardware Information window), clicking the OK control 
button will start a transfer of the new Inclusion List data to the hardware. This 
process can be monitored on the Flash Hardware and NDC Hardware Connection 
Status windows. 
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6. The Flash Hardware window will display the success status of the transfer and then 

disappear. The full transfer conversation can be viewed on the NDC Hardware 
Connection Status window (for advanced users only). 

 
 
Note: 

1. The RS-232 port data and CAN bus data are unaffected by the NMEA Inclusion Lists 
and retains all received data – as these ports always have an excess transmit 
bandwidth/capacity. 
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Port Configuration tab 

 

 
 

Figure 8 – Control Centre Port Configuration tab 
 
 
The Port configuration tab of the main window allows the user to determine the priority and 
Baud rates of the NMEA input ports of the NDC hardware, the Baud rate of the RS-232 port 
and if the NMEA proprietary ARL (P-codes) sentences are transmitted. 
 
These P-codes are used by the Control Centre to determine the NDC Hardware Port 
Status and the original NMEA input port number the data (displayed in the Control Centre 
Port Status window) came from. As a result, the P-codes should always be enabled when 
using the NDC hardware with the Control Centre – otherwise the port status windows will be 
unable to operate. If however, the RS-232 port is connected to an electronic device (e.g. 
chart plotter) that cannot ignore the P-codes (as it should by default), then the P-codes can 
be disabled to aid compatibility. 
 
 
Why is there a need for Port Priorities? 
 
Refer to ‘Why is there a need for Inclusion Lists?’ for the detailed explanation for the 
need to potentially reduce the amount of data trying to be sent out of the combined output. If 
the Inclusion Lists cannot reduce the data rate below the 480 bytes/second maximum, then 
the port priority system comes into operation. 
 
This system stipulates that all the data from the highest priority port will be passed through to 
the combined output. Then if any transmit capacity is left, the next lowest priority port’s data 
is transferred until either no data remains (the usual case), or transmit capacity has reached 
its maximum of 480 bytes/second. 
 
If the rate of data in to the NDC hardware continues at this very high level, then eventually 
some sentences (from the lowest priority channel first) will have to be dropped. If however, 
the rate drops below the maximum, then the sentence data will be sent at the next 
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opportunity. With the ‘Inclusion Lists’ set up correctly, data loss will be a very rare 
occurrence.  
 
 
How to change the Port Priorities and Port Baud rates 
 
The port configuration tab consists of a vertical port priority list, a Baud rate pull-down list for 
each NMEA/RS-232 port, the P-code enable toggle control, and Get from hardware, Reset 
and OK control buttons (refer to figure 8). 
 

Port priority vertical list: utilises a simple priority system – the topmost item has the 
highest priority and the item at the bottom, the lowest. 
 
NMEA/RS-232 Baud rate lists: selects the required baud rate for the appropriate port. 
Please note that the NMEA 0183 specification stipulates that the baud rate for NMEA 
data must be 4800 Baud. Therefore, any input NMEA port that has an NMEA device 
attached to it that cannot modify its Baud rate must remain at 4800 Baud (otherwise no 
data will be received). However, some NMEA devices (e.g. GPS units) do allow for the 
Baud rate to be increased to 9600 Baud. Only in this case can the baud rate of the 
appropriate port be changed to match that of the attached device. 
 
P-code enable: toggles the enable/disable state of the P-code transmission on the 
RS-232 port. 

 
Get from hardware: requests the current Port Configuration information (for all 
channels/ports) from the NDC hardware attached to the PC communications port. This 
will overwrite any current settings of the Control Centre’s Port Configuration; if the user 
requires that the current settings be remembered, the File → Save Configuration file 
main window menu option should be used before using this hardware read operation. 

 
Reset: returns all channel port configurations to the factory default – priorities match 
channel/port numbers (port 1 has highest priority and port 4 has the lowest), NMEA 
Baud rates are set to 4800 Baud, RS-232 Baud rate set to38400 Baud and the P-
codes are enabled. 
 
OK: finalises the port configuration editing operation. If any alterations to the port 
configuration settings have occurred the Control Centre will now attempt to download 
the new settings to the attached Actisense NDC hardware. The operation is very short 
in duration (less than one second). 
 
 

Procedure 
1. The RS-232 communication port defaults to 38400 Baud, which is more than capable 

of transferring the received data of all four NMEA input ports. When connected to a 
Personal Computer there should not be any reason to change this Baud rate. 
However, if it is required to connect the NDC hardware to an RS-232 compatible 
device that does not support the Baud rate of 38400, then the rate can be changed. 
Left click on the RS-232 Port controls down arrow to display the list and then select 
the required Baud rate number. 

 
2. The proprietary NMEA P-code sentences sent by the NDC hardware are completely 

benign and cannot be understood by any other manufacturers device. The 
Actisense software programs (Control Centre and Flash Centre) use these 
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sentences to perform certain operations that enhance their control over the NDC 
hardware and are therefore important. There should not be any reason for requiring 
that these sentences be disabled. However, as Actisense believes in offering 
complete control over its products, it is possible to enable/disable these sentences by 
clicking on the P-codes Enable/Disable control. 

 
3. As detailed above, the NMEA 0183 standard determines the Baud rate of 4800. If 

however to make the NMEA input compatible with special devices that offer a 
different Baud rate, the rate can be changed by left clicking on the NMEA Port 1-4 
pull-down lists. 

 
4. To aid memory, it would be normal to keep the port priorities in the same order as the 

port numbers (i.e. port 1 has the highest priority and port 4 the lowest). However, if 
for some reason the port priorities require change and it is inconvenient to change 
the hardware crimp connections, the port priorities can be changed using the Port 
priority list. 

 
5. Once all the changes have been preformed, press the OK control button to transfer 

the new port configuration data to the attached NDC hardware. As for the ‘Inclusion 
List’ data transfer, if the NDC hardware has not been detected, the Control Centre 
will not start the transfer. If this happens check all cable connections, Control Centre 
communication settings (port number and Baud rate) and battery power to the NDC 
hardware (the diagnostic LED should be lit and either ‘Green’ or ‘Amber’). 

 
6. When the Control Centre has detected the NDC hardware (the hardware information 

will be displayed in the NDC Hardware Information window), clicking the OK control 
button will start a transfer of the new Port Configuration data to the hardware. This 
process can be monitored on the Flash Hardware and NDC Hardware Connection 
Status windows. 

 
7. The Flash Hardware window will display the success status of the transfer and then 

disappear. The full transfer conversation can be viewed on the NDC Hardware 
Connection Status window (for advanced users only). 

 
 
Note: 

1. The RS-232 port data and CAN bus data are unaffected by the NMEA Inclusion Lists 
and retain all received data – as these ports always have an excess transmit 
bandwidth/capacity. 
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Flash Hardware window 

 

 
 

Figure 9 – Control Centre Flash Hardware window 
 
 
The Flash Hardware window is displayed for the duration of the Inclusion List or Port 
Configuration update operation. In the case of the Inclusion List, during this time a section of 
the Flash memory inside the NDC hardware is first erased/cleared and then re-programmed 
with the new data. 
 
Please note that it is vital that during the programming stage of this process that the Control 
Centre and NDC hardware are not interrupted. Therefore, the following precautions are 
suggested: – 
 

1. Ensure there are no programs active/running on the PC other than the Control 
Centre. 

 
2. Check the RS-232 cable between the PC and the NDC hardware is secure. 

 
3. Confirm that the battery supply to the NDC hardware is secure. 

 
If the Flash hardware operation is interrupted, the Inclusion Lists or Port Configurations will 
become corrupted. The user should identify and then remove the reason for the previous 
interruption and then attempt to flash the hardware again – by returning to the Inclusion List 
configuration tab or Port Configuration tab and pressing the OK control button again. 
 
The Flash Hardware window consists of four LED’s that indicate the flash operations current 
status, a progress bar indicating percentage complete of current stage, and a flash program 
counter that indicates how many times the NDC hardware’s Inclusion List has been re-
programmed. 
 
The Success LED will indicate the final outcome of the data transfer. If for some reason it 
does not light up green the NDC Hardware Connection Status will indicate a more detailed 
cause and the process should be performed again. 
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The following windows/tabs will only be of interest to the advanced user as they are not vital 
for the configuration of the NDC hardware. These windows are therefore hidden by default, 
and all novice users should advance to the Using the Flash Centre section. 
 
 
Test Hardware tab 

 

 
 

Figure 10 – Control Centre Test Hardware tab 
 
The Test Hardware tab of the main window enables the advanced user to test the NDC 
hardware’s RAM. This operation will only require completion when the hardware is 
suspected of being faulty and at the request of an Actisense support team member. 
 
The Test Hardware tab consists of four stage-status LED’s (Overlay, Connected, Running 
and Success), an LED and associated ‘Number of Errors’ text box for each of the memory 
tests, a progress bar indicating progress of current stage, and the Memory Test and OK 
control buttons. 
 

Memory Test: initiates the memory test. The test currently underway is indicated by 
the associated test LED and any accrued error count is displayed in the ‘Number of 
Errors’ box. 
 
Once the memory test has completed, the NDC hardware will be reset and restarted. 
 
OK: resets the Test Hardware settings to allow for another test to be started by the 
Memory Test control button (if so desired). 

 
If the test indicates a RAM error and all connections to the NDC hardware are proven 
correct, the user should consult the Troubleshooting guide. 
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Control Centre Port Status window 

 

 
 

Figure 11 – Control Centre Port Status window 
 
 
The Control Centre status window displays all information relating to the communications 
port open between the Control Centre and the NDC hardware. This includes data received 
(from the NDC hardware) and data sent (to the NDC hardware), and the bytes-per-second 
transfer rate / buffer loading rate for both directions of the communications port. 
 
This data is valuable in monitoring the performance of the NDC hardware, and as a 
diagnostic tool for pinpointing a port overload condition (this is when the maximum data 
transfer rate of a port is trying to be exceeded, and data is being lost as a result). 
 
 
NDC Hardware Port Status window 

 

 
 

Figure 12 – NDC Hardware Port Status window 
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The NDC hardware status window, like the Control Centre Port Status window, displays 
bytes-per-second transfer rates and buffer loading rates for a number of ports. However, 
these values relate to the ports on the NDC hardware – the four NMEA input ports, NMEA 
combined output port and the RS-232 input/output port. 
 
This data is also valuable in monitoring the performance of the NDC hardware, and as a 
diagnostic tool for pinpointing an overload condition (refer to Control Centre Port Status for 
more details). 
 
 
NDC Hardware Connection Status window 

 

 
 

Figure 13 – NDC Hardware Connection Status window 
 
 
The NDC hardware connection status window displays all information related to the 
connection status between the Control Centre and the NDC hardware. This includes all 
handshaking and data transfer information required for flash programming the NDC 
hardware during Inclusion List and Port configuration data updates. 
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NDC hardware information window 

 

 
 

Figure 14 – NDC Hardware Information window 
 
 
The NDC hardware information window displays the information received from the NDC 
hardware after being requested by the Control Centre. This information Includes: - 
 

1. The hardware Serial ID number – the unique serial identification number give to 
each NDC. This number is used to identify each NDC unit in our records. 

 
2. The bootloader and main program software version numbers, and the program 

creation dates and times both of these. 
 

3. The NMEA 2000 version currently supported by the NDC hardware. This will initially 
be “0.01”, indicating that the NMEA 2000 specification is not currently available, as it 
is yet to be released. Once the NMEA committee finalise the standard, work will 
begin on providing a Flash update to expand the hardware’s abilities to include 
NMEA 2000. Please visit the Actisense website for up to date information on this 
subject. 

 
4. The Total time that the NDC hardware has been operating for since new. 

 
5. The Manufacturers Model (0 = NDC) and product codes (hardware revision number). 

 
6. The flash program counters for each sector of the hardware’s Flash ROM. 

 
7. Customer details (as known at time of despatch/initial program at factory). 
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Using the Flash Centre 
 

 
 

Figure 15 – Flash Centre main window 
 
 
The Flash Centre main window has a very simple look, as the Actisense NDC main 
program flash update process has been completely automated for a trouble-free operation. 
 
The NDC hardware should be connected to the PC communications port and a battery 
supply as per the instructions in the Connecting to a Personal Computer section and 
Figure 3 (RS-232, CAN Bus and Battery connections). 
 
 
Pull-down menus 

 
The main window has three standard pull-down menus: - 
 

File → Exit: Closes the Flash Centre program.  
 

Comms → Comm Port 1-5: Selects the PC communications port that the NDC 
hardware is attached to (via the extension cable). 
 
Comms → Baud rate 19200-115200: Selects the PC communications port Baud rate 
to match that of the NDC hardware attached to the port. The baud rate will default to 
38400 (the NDC hardware default). If received data errors are detected the Flash 
Centre will attempt to match the NDC hardware’s Baud rate. 
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Help → Flash Centre Help: Displays the quick reference Flash Centre help 
information (a cut-down context sensitive version of this document). 
 
Help → About Flash Centre: Displays the Flash Centre’s software version number 
and the Actisense / Active Research Limited contact information. 

 
 
Control Buttons and Text Displays 

 
The Flash Centre main window consists of the Hardware Connection Status text box 
(identical that in the NDC Hardware Connection Status window of the Control Centre), 
Current Version and New Version text boxes, the update progress bar, and the Update 
Flash and Exit control buttons. 
 

Connection Status: displays all handshaking and data transfer information required 
for flash programming the NDC hardware during the main program update. 
 
Current Version: displays the main program version currently resident in the NDC 
hardware’s Flash ROM. This is received from the NDC hardware when the Flash 
Centre detects the hardware’s presence and requests the hardware information. 
 
New Version: displays the main program version that the Flash Centre can upgrade 
the NDC hardware to. This number must be greater than the Current Version for an 
update to be required (and allowed) by the Flash Centre. 
  

 
 

Figure 16 – Flash Centre “Hardware already up to date” message 
 
 
If the New Version is older or equal to the Current Version, then the Flash Centre will 
block all attempts to update the NDC hardware – as there is nothing to be gained, and 
perhaps a reduction in functionality and performance. 
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Update Flash: initiates the flash update of the NDC hardware’s main program. If the 
NDC hardware has not been detected, the Flash Centre requests a confirmation from 
the user. 
 

 
 

Figure 17 – Flash Centre “Hardware not detected” message 
 
 
As the message explains, if the diagnostic LED is lit and ‘Green’ in colour, check all 
cable connections, Flash Centre communication settings (port number and Baud rate) 
and battery power to the NDC hardware. Press the Cancel button. Once the problem 
has been found the Current Version box will display the hardware’s version number 
and the Update Flash control button can be pressed. 
 
If however, the diagnostic LED is lit and ‘Red’ in colour AND there was an interruption 
to a previous attempt to update the hardware’s main program with the Flash Centre, 
reset the NDC hardware (by removing the battery power, waiting 5 seconds and then 
reconnecting the battery power), and press the Continue button. 
 

 
 

Figure 18 – Flash Centre “Update Hardware’s Inclusion List” message 
 
 
The final message displayed (or only message if there are no problems) asks the user 
if they require that the NDC hardware’s Inclusion List be reset back to factory defaults, 
or kept as is. The normal answer is No, keep the current settings, but if the user would 
like to take this opportunity to reset the Inclusion Lists then select Yes. 
 
The Inclusion Lists can also be reset back to the factory defaults by using the Control 
Centre (refer to How to change the Inclusion Lists section). 
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Figure 19 – Flash Centre Flash Hardware window 
 
 
Once started the Flash Hardware window will be displayed and the progress indicated 
by the four-stage status LED’s and the progress bar. The Hardware Information 
Status box will display the relevant information during the process. 
 
The user is not required to interact with the process during the update. Once complete 
the NDC hardware will be automatically reset and the new Current Version number 
will be displayed (which now matches the New Version number). 
 
Exit: once the flash process is complete (indicated in the text box and on the progress 
bar), the user can exit from the Flash Centre by press the ‘Exit’ control button. The 
‘Exit’ button is not active during the flash process. 

 
 
Please note that it is vital that during this process the Flash Centre and NDC hardware are 
not interrupted. Therefore, the following precautions are suggested: – 
 

1. Ensure there are no programs active/running on the PC other than the Flash Centre. 
 
2. Check the RS-232 cable between the PC and the NDC hardware is secure. 

 
3. Confirm that the battery supply to the NDC hardware is secure. 

 
If the Flash Centre operation is interrupted, the main NDC program will become corrupted. 
The user should identify and then remove the reason for the previous interruption and then 
attempt to flash the hardware again – by following the on-screen messages carefully. 
 

 © Active Research Ltd.      Page 30 of 36     8 February 2002 



 NMEA Data Combiner
Troubleshooting guide 
 
This guide will concentrate on all relevant troubleshooting issues above simple cable 
connection faults. Therefore, the cables between the NDC hardware and any other device 
should be checked as a matter of course before continuing with this guide. 
 
 
Diagnostic LED 

 
The NDC hardware supports a tri-colour diagnostic LED that can indicate the current 
operating mode of the hardware and if any error has been detected during the self-test 
initiation process. Table 1 details what each LED colour represents and if any user 
interaction is required: - 
 

LED Colour / 
Flash Count Mode / Error condition Required user response 

Red,  
No flashing 

Start-up mode, 
No error 

No response required. A normal operation mode 
that should last for 1.5 seconds. Any longer 
indicates an error with the main program. 

Amber, 
No flashing 

Initialise and self-test mode, 
No error 

No response required. A normal operation mode 
that follows after the Start-up mode and should 
last for approximately 1 second. 

Green, 
No flashing 

Normal and no data mode, 
No error 

No response required. A normal operation mode 
that follows the Initialise and self-test mode. 
Indicates that no error was detected during the 
self-test operation.  
 
Also indicates that no data is currently being 
received by the NDC hardware. 

Green, 
Flashing  

(1-10 per second) 

Normal and data Rx mode, 
No error 

No response required. A normal operation mode 
that indicates that data is currently being 
received (on at least one channel) by the NDC 
hardware. 

 Error conditions. 
If the error persists the NDC unit should be 
returned to Actisense (refer to the Contact 
Information section). 

Amber, 
Flashing 

(Once every 4 
seconds) 

Error trap mode, 
EEPROM memory error 

An error with the EEPROM memory has been 
detected during the self-test mode. 
 
Reset the NDC hardware.  

Amber, 
Flashing 

(Twice every 4 
seconds) 

Error trap mode, 
RAM memory error 

An error with the RAM memory has been 
detected during the self-test mode. 
 
Reset the NDC hardware.  

Amber, 
Flashing 

(Thrice every 4 
seconds) 

Error trap mode, 
EEPROM memory error 

An error with the EEPROM memory has been 
detected during the self-test mode. 
 
Reset the NDC hardware. 

 
Table 1 – Diagnostic LED colours 
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Control Centre Error Status window 

 

 
Figure 20 – Control Centre Error Status window 

 
 
The Control Centre will display any error information received from the NDC hardware in a 
window like those in Figure 20. If this window is displayed, follow the message instructions 
carefully and then contact Actisense / Active Research Limited. 
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Block Diagram 
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Figure 21 – NMEA Data Combiner Block Diagram 
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Specifications 
 
Symbol Parameter Conditions Min. Max. Unit 

Supply 

VB Supply voltage  7 28 V 

Supply voltage = 12v 100 110 mA 
IB Supply current 

Supply voltage = 24v 50 60 mA 

NMEA 

Logical ‘1’/stop bit -15.0 0.5 V 
VNMEA I Input voltage between +/- 

Logical ‘0’/start bit 4.0 15.0 V 

INMEA I Input current Maximum is under +35v 
overload condition 2.0 30 mA 

VNMEA ID Differential input voltage Required level for NMEA to 
be detected 1.8 2.0 V 

Logical ‘1’/stop bit 0.0 0.5 V 
VNMEA O 

Output voltage between +/- 
and ground (see note 1) Logical ‘0’/start bit 4.8 5.2 V 

INMEA O Output current (see note 1)  15.0 40 mA 

INMEA SC Output short circuit current.   35 250 mA 

BNMEA Baud rate (see note 2)  2.4 9.6 kbit/sec 

tNMEA PD Data propagation delay  1.0 100 ms 

RS-232 

VRS232 IR Input voltage range  -15 +15 V 

LOW 0.8 1.2 V 
VRS232 IT Input voltage threshold 

HIGH 1.7 2.8 V 

VRS232 O Output voltage swing  Loaded with 3κΩ to Ground ±5 ±9 V 

RRS232 O Output resistance VRS232 O  = ±2V 300  Ohms 

IRS232 SC 
Output short circuit current 
(Infinite duration)   ±18  mA 

BRS232 Baud rate  19.2 115.2 kbit/sec 

tRS232 PD Data propagation delay  1.0 100 ms 
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Symbol Parameter Conditions Min. Max. Unit 

CAN Bus 

VCAN P 
Supply voltage for CAN Bus 
circuitry (see note 3)  7 28 V 

Dominant bit (CANH/L) - 70 mA 
ICAN P 

Supply current for CAN Bus 
circuitry (see note 3) 

Recessive bit (CANH/L)  - 18 mA 

VCAN HL 
CANH, CANL input/output 
voltage  -8 +18 V 

RCAN I 
CANH, CANL input 
resistance  5 25 kΩ 

CCAN I 
CANH, CANL input 
capacitance   - 20 pF 

ICAN SCH CANH short circuit current CANH = -5V -105 -120 mA 

ICAN SCL CANL short circuit current CANL = 18V - -160 mA 

General 

TA Ambient temperature  -40 +80 °C 

 
Table 2 – NDC specifications 

 
 
All specifications are taken with reference to an ambient temperature (TA) of +25°C. 
 
Note: 

1. NMEA output is RS-485 compatible. 
 

2. NMEA 0183 stipulates the use of 4800 Baud (factory default). However, to maximise 
compatibility with other standards, the baud rate is selectable between values shown.  

 
3. The Can Bus circuitry is power directly from the CAN Bus to conform to the NMEA 

2000 standard specification of galvanic isolation. 
 

 © Active Research Ltd.      Page 35 of 36     8 February 2002 



 Actisense 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Company Information 
 
 
Active Research Limited 
5, Wessex Trade Centre 
Ringwood Road 
Poole 
Dorset 
UK. 
BH12 3PF. 
 
Telephone:  01202 746682  (International : +44 1202 746682) 
Fax:    01202 746683  (International : +44 1202 746683) 
 
Actisense on the Web : For advice and product details 
 
E-mail:   support@actisense.com 
Website:  www.actisense.com 
 
Active Research on the Web : For specialist consultancy and customisation 
 
E-mail:   support@activer.com 
Website:  www.activer.com  
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